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Before we get started, some helpful tips: 

• Have a clear idea of the purpose of your report.  For example, I need a list of clients’ 
names, URNs, gender, and race. 
 

• Make sure that the report is pulling the information you believe it is. One easy way to 
verify this is to add more fields in your report and then use Excel or another program to 
further manipulate the data.  In addition, spot check your report; choose 5 or more 
observations at random, and then go into their client record to verify that the 
information matches. 

 
• Creating any type of data report is a skill that takes time to develop.  Make sure to set 

aside large blocks of time as you begin to work on your reports. 
 

• Be patient.  CAREWare is accessed through a remote desktop, and it takes time for 
messages to be transmitted.  Wait for the Communicating light bulb symbol in the 
bottom right hand corner to clear before clicking any other buttons. 
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1. Accessing the Custom Reports Window: 

Log in to CAREWare and on the first screen, click Reports.  

 

In the next window, click Custom Reports. 

 

 

 

 

CAREWare Custom Reports Guide • May 2014 | Ryan White Part A, Las Vegas TGA 4 

 



In the Custom Reports window, you can select from a list of existing reports or create a new 
report.  Below is an overview of the different fields in the Custom Reports window. 
 

 
1. Data Scope – You can use the options to select specific records.  When using this feature, 
spot check records to ensure that your report is truly pulling the data intended. 
 
2. Filter by Report Type – If you have a large number of reports in your report queue, you can 
use this drop down menu to select the report type you want. 
 
 

 
 
 
 

CAREWare Custom Reports Guide • May 2014 | Ryan White Part A, Las Vegas TGA 5 

 



3. Date Span – Depending on the report type you select, the date span will refer to different 
variables.  Please refer to the table below to determine which date variable each report type 
uses. 
  

Date Range Selection for Custom Reports 
Report Type Client Records Included in Custom Report if Specified field within Date 

Range 
Custom subform Custom subform date 
Demographic Includes clients with at least one service visit during the date range 
Diagnoses Diagnosis date (tab not commonly used in Las Vegas TGA) 
Immunization Immunization date (tab not commonly used in Las Vegas TGA) 
Lab Lab test date 
Medication No stop date or stop date within range 
Pregnancy history Estimated conception date 
Referrals Referral date 
Screening Screening test date 
Screening labs Screening lab test date 
Service Service visit date 
Vital signs  Encounter date 
 
 
4. Clinical Review Year – If you are reporting over 2 or more calendar years, the Clinical Review 
Year drop down menu allows you to specify which year’s annual review data you want to use. 
(This is important if you are using annual review data in your report, such as income, HIV status, 
etc. which may change over time). 
 
5. Show New Clients Only – When selected, will only show clients who became new clients in 
the specified date range, based on their enrollment year. 
 
6. Show Specifications - When selected, will display the criteria the report is run on. 
 
7. Sum Numeric Fields – When selected, will display the total of any numeric fields at the 
bottom of the report. 
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2. Run an existing report: 
 
Select the report you would like to run from the report queue.   
 
Choose the appropriate Date Span, and if the dates cross 2 or more calendar years, in the 
Clinical Review Year, enter the year from which you would like to use annual review 
information. 
 
When you have entered this information, click Run Report. 

 
 
When the report is done running, a window like the one below will appear.   
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If you would like to export the report to your computer as an Excel file, click File in the top left 
hand corner, and then click Export. 

 
 
 
The Export window will appear.  From the Export Type drop down menu, select Microsoft Excel 
Format (XLS).  
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Then click the ellipsis next to File.  

 
 
The Save As window will appear. Here you will indicate the name of the file and where it will be 
saved on your computer.   

 
 
1. CAREWare is hosted on a virtual computer, so the first files that appear will be on the virtual 
computer.  DO NOT save files to this location.  Look for your computer’s name, which will 
typically be a series of letters and numbers.  Click on the folder locations and see if they look 
familiar.  Once you verify that it is your computer, select which folder you would like to save the 
file to. 
 
2. Use the File Name field to label the file with a name that helps you to easily identify its 
contents.  It is good practice to include keywords and the date span in the file name. 
 
3. When you have entered all this information, click Save. 
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You will be taken back out to the export window.  Click OK, and wait for the file to export.  
Depending on the size of the file and speed of the connection, this may take several minutes. 
When the report is done running, the Export window will close.  Go to where you saved the file 
and open it to make sure that it exported correctly. 
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3. Create a new report: 
 
To create a new report, click New Report in the Custom Reports window. 

 
The Custom Report Add window will appear 

 
 
1. Enter a name in the Report Name field that will help you easily identify the report in the 
queue. 
 
2. Choose the type of report from the Report Type drop down menu.  Certain fields are only 
available under certain report types, however, demographics fields are available within all 
reports. 
 
3. Click Field Selection to choose which variables you would like to add.  The following window 
will appear 
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Click Add Field. 

  
The Field Dictionary for Service Report window will appear.   

 
Look for the name of the field or type all or part of the name at the top to help narrow down 
the list.  For example, if you want to include the client’s URN in the report, you can type URN at 
the top, and only fields that have URN in their name will appear in the list. 
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To get more information about a field you are interested in, highlight the field, and then click 
View Field Description at the left. 

 
 
 
 
 
A Field Description window like the one below will appear.  Not all fields have a field 
description, so you may need to conduct further investigation to better understand how the 
field relates to the data entered in CAREWare. 
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Once you determine that this is the field you want to use, highlight the field and click 
Select/Use Field on the left. 

 
 
 
 
In the next window, you are given options for how to modify the format of the report.  You can 
also make these changes later on in Excel or another program.  Review the information in this 
window and click Save to add the field to the report. 
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You will be taken back out to the Field Selection window.  You can add more fields by clicking 
Add Field and following the same process. 
 

 
 
If you want to change the order of the fields, highlight the field you would like to move, and 
then use the arrows at the right to move it up or down. 
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If you are ready to run your report, click Close in the top right hand corner. 

 
 
 
 
You will be taken out the Custom Report Edit window. Click Save in the bottom left hand 
corner. 
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In the Custom Reports window, make sure the report you want to use is highlighted.  Review 
the Date Span and Clinical Review Year to make sure they are correct, and then click Run 
Report. 

 

When the report is done running, the Report Viewer will appear.  To export the report to your 
computer, follow the instructions on pages 8 - 10. 
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4. Add a report filter: 
 
Use the report filter to filter your data. (It is a good idea to include field selections that will 
verify your filters are working as intended.) For example, if you filter your report to only include 
Females, you would want to include Gender as one of the fields in your report. 
 
Generally, it is good practice to first run your report without any filters so that you can verify 
that the correct data are being pulled. You can then add filters to the report. It may also be 
more efficient to use Excel or another program to manipulate and filter your report. 
 
In the following example, we will use a filter to only include females in our Clients by Race and 
Gender report. 
 
Highlight the report you want to add a filter to, and then click Edit Report on the right hand 
side. 

 
 
Then, in the Custom Report Edit window, click Report Filter. 
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The Custom Reports – Filter window will appear.  Click Add Criterion at the bottom. 

 

 

The Field Dictionary window will appear.  Find the field you would like to use, either by scrolling 
through the list, or entering part of the name of the field at the top.  Once you find the field you 
want to use, click on it to highlight it, and then click Select/Use Field in the top left hand corner.  
If you want to know more about the field, click F3: View Field Description to see if there is 
more information in the Field Dictionary.  
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You will be taken back to the Filter window.  Use the drop down menu to select which value 
you would like to use.  In this example, we will choose Female. 

 
 
 
Review the information in the Filter window, and click Add Criterion at the bottom to add the 
filter to the report. 

 

If this is the only criterion you would like to add, click Close and then follow the steps on pages 
7 – 10 to run and export the report. 
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You can also add additional criteria.  For example, if you are interested only in women age 13-
24, we can add a criterion for age.  Click Add Criterion at the bottom of the page.  

 

 

 

Select the Age field from the field dictionary, and click F1: Select/Use Field. 
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You will be taken to the Filter window. 

 
 
1. Select AND or OR from the Operator list.  

- AND means that the outcome has to satisfy both conditions at the same time. 
- OR means that the outcome has to satisfy one condition, or the other condition, or both at 

the same time. 
Since we want to include only women who are 13 – 24 years old, we will choose AND. 

 
2. Enter the lower limit of the age range in this field. 
 
3. Enter the upper limit of the age range in this field. 
 
4. Review the information in the window and click Save. 
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When you are done adding criteria, click Close and you will be taken to the Custom Report Edit 
window where you can save, run, and export the report. 
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4. Save a filter as a template: 
 
You can save a filter you create as a template.  This allows you to apply the filter you’ve created 
to any report type.  For example, let’s say we would like to easily apply the criteria of Female 
AND age 13-24 to other reports. 
 
Click templates in the bottom left hand corner. 

 
When you click on Templates, The Filter Templates window will appear.  Click Save to New 
Template on the left. 

 
 
Enter a descriptive name in the Name Template window and then click Save.  The template is 
now available for you to use in other reports of the same type (e.g. this is a service report, so 
this template is only available for other service reports). 

 

CAREWare Custom Reports Guide • May 2014 | Ryan White Part A, Las Vegas TGA 24 

 



To apply this template to another report, edit the report you would like to use and click on 
Report Filter. Click Templates in the bottom left hand corner. 

 

Select the name of the template you want to use, and then click FI: Use Selected Template. 

 

You will then see the criteria in the Filter window. 
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6. Using the Group Format Wizard: 
 
The Group Format Wizard allows you to put any continuous, quantitative field into categories, 
for example, dates, lab results, etc.  
 
If a field can have a group format applied to it, you’ll see the Format link above the field name.  
You can use the Group Format Wizard from either the Field Selection or Report Filter windows. 
 
Let’s say that in the previous Clients by Race and Gender report, instead of including only 13-24 
year olds, we wanted to group people into the following age categories: 0-12, 13-24, 25-34, and 
35+. 
 
From the report queue, select the name of the report you want to use.  Click Edit Report on the 
right hand side, and then click Field Selection in the Custom Report Edit window. 
 
In the field selection window, click the field you want to format and then click Edit Field. 

 

Click Format at the top left. 
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The Group Format Wizard window will appear.  Select Make a new group format and then click 
Next. 

 

 

 

In the next window, click Add. 
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For the first interval, enter the upper limit.  Since our first interval is 0-12, enter 12 as the Max 
Value and 0-12 as the label. Then click Save.  

 
 
 
 
Our next interval is 13-24, so we will enter 24 as the Max Value and 13-24 as the label. 
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Add additional intervals in the same way.  You can edit the label of the last interval by clicking it 
and then clicking Edit. 

 

You can then enter a more descriptive label such as 35+.  Click Save when you are done. 
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When you are done creating intervals, click Next.  

 

If you would like, you can save the template so that it can be used in other reports.  Enter a 
descriptive name, and click Finish. 
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To use the format once you have saved it, select the format name from the Existing Templates 
list, choose Use selected group format template, and then click Finish. 

 

 

 

To remove a group format template, select and edit the field you are interested in. Then click 
Format in the top right hand corner. 
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The Group Format Wizard will appear.  Select Do not format this field, and then click Finish. 
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6. Microsoft Excel Tips and Tricks: 

CAREWare has many features for manipulating the data in your reports, however, it is generally 
most efficient and accurate to use another software program to manage, manipulate, and 
analyze your CAREWare reports. Microsoft Excel is widely available and used, so we will review 
a few Excel tips and tricks.   
 
We will use the following report to walk through some examples. 

 
 
Before working with a report, it is good practice to back up your report by copying the file and 
then also creating a copy of the worksheet in your Excel workbook.  You can do this by right 
clicking on the sheet’s name, and then clicking Move or Copy. 
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The Move or Copy dialog box will appear.  Make sure to check Create a copy and then click OK. 

 
 
A duplicate sheet named service(2) will be created.  You can rename it by right-clicking and 
choosing Rename.  You can then type in a new name, for example Service Scratch 
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Using the Count Feature 
 
A quick way to count the number of observations in your report is to look at the Count at the 
bottom right.  Click the top of one of the columns and the count of observations in that column 
will appear at the bottom right. 
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Using the Sort Function 
 
The sort function can put your data in alphabetical and/or numerical order by using one or 
more fields.   
 
Under the Data Tab, click Sort. 

 
 
In the Sort window, make sure that My data has headers is checked at the top.  Choose the 
name of the column you want to sort by under Sort by. For Sort On, you will almost always 
choose Values.  For Order, choose A to Z or Z to A. 

 
 
To add another level, click Add Level in the top left hand corner.  This allows you to sort by two 
columns.  For example, if we set up the Sort window like the one below, Names will first be put 
into alphabetical order, and then services will be organized by date, first to last. 
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Using the Filter Function  
 
The filter function can be used to quickly look at the categories and observations in your report.  
Click on one of the active cells in your report and under the Data Tab click Filter.  The Filter Icon 
will become yellow and grey boxes will appear in the right hand corner of the cells in the top 
row.   
 
Click on the grey box of a column to see which values it contains.  You can hide certain values 
by clearing the check box next to it. 
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One common criterion you may need to use in your reports is including only Ryan White Part A 
contract services.  You can do this by unselecting Part A, and then deleting all the rows except 
for the top row of labels.   
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Highlight the rows you want 
to delete.  Then right click to 
pull up the delete command. 
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Then go back to the filter and select Part A and click OK. 

 
 
 
 
 
 
 
The report now contains only Part A services.   
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Removing Duplicates 
 
Many Ryan White reports ask for the number of total services provided and the number of 
unduplicated clients.  The Remove Duplicates feature can be used to easily remove duplicates. 
To ensure that your data does not get lost, create a backup copy of your report. 
 
Click the Data tab and then click Remove Duplicates.  

 
A window will appear asking you which columns contain duplicate values.  Make sure to check 
My data has headers at the top so that the column labels are not included as field values.   
 
Choose the columns you would like to include in the criteria for removing duplicates.  If you 
select only URN, this will remove any duplicate values in the URN column alone.   

 
In our example report, if we choose URN only, only the 5 rows with unique URNs will remain.  
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For most reports, however, you will want to know the number of unique clients per service 
category, so choose both the URN and service category to remove any duplicate values based 
on column AND URN.  
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PivotTables 
 
PivotTables offer a quick way to filter, stratify, and display data in a table. 
  
Click on an active cell in your report.  Then click the Insert tab, click PivotTable, and then click 
PivotTable.    

 

 

 

 

 

 

 

 

 

 
 
 
 
Make sure the full range of your report is selected, and then choose to have your PivotTable 
placed on a new worksheet. 
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In the PivotTable, you can drag fields to the areas in the PivotTable Field List, or drag and drop 
them directly into the fields on the worksheet. 

 
 
 
 
 
To add a filter, drag the field you would like to filter on to the Report Filter box. Click the grey 
arrow button to select which values you want to filter by. 
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We can then quickly create a report by dragging and dropping different fields to the Row 
Labels, Column Labels, and Values boxes. 
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8. Commonly Used CAREWare Fields 
 
CAREWare has thousands of fields, and all of these fields are listed in the Field Dictionary, 
which can cause confusion when selecting fields for Custom Reports. Some fields are specific to 
certain agencies, and many of the fields are not used by agencies in the Las Vegas TGA.  In 
addition, many of the fields are calculated fields, meaning they are generated based on data 
entered into CAREWare. It is important to always spot-check a few clients in your report to 
make sure that the correct fields were selected and they are being calculated accurately.   
 
Calculated Fields 
 
For calculated fields, CAREWare often requires that you enter additional criteria to define the 
field. If this is needed, the following window will appear: 

 
 
Click OK, and then in the Field Selection window, click the ellipsis next to the field name. 
 
 
 
 
 
 
 
 
 
Go through the list of criteria, and for each one click Edit Criterion and set the parameters. 
Domain Wide refers to whether data entered by your agency only or all agencies where the 
client receives services will be included.  Choosing Yes will include all agencies that provide 
services to the client. 
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Table of Fields Commonly Used in CAREWare 
 
The following table lists the CAREWare fields most commonly used by providers in the Las 
Vegas TGA.  This is a brief overview and not an extensive list of all the fields available for use. 
 
 
CAREWare Fields Commonly Used by Providers in the Las Vegas TGA 

Variable Name CAREWare Field Report Type Description/Values 

Client Identifiers Generated by CAREWare 
URN Generated by CAREWare on 

Demographics Tab 
All report types Unique Record Number; provides a 

unique ID for each client based on 
Gender and DOB 

eURN Generated by CAREWare on 
Demographics Tab 

All report types Encrypted Unique Record Number; 
provides a unique ID for each client 
without using characters from name 
or DOB 

UCI Generated by CAREWare on 
Demographics Tab 

All report types Unique Client ID; provides a unique 
ID for each client based on Gender 
and DOB 

eUCI Generated by CAREWare on 
Demographics Tab 

All report types Encrypted Unique Client ID; provides 
a unique ID for each client without 
using characters from name or DOB 

Fields on Demographics Tab 
Name First and last name entered 

on Demographics Tab 
All report types Follows format: 

Last Name, First Name 
Gender Gender on Demographics Tab All report types - Male 

- Female 
- Transgender 

Age Calculated based on DOB and 
end date 

All report types Client’s age as of the end date of the 
report. If no dates are specified in 
the report, then it is as of the date 
the report is run.  There are several 
age fields in CAREWare.  Use the 
View Field Description command to 
verify how age is being calculated. 
 

Race/Ethnicity Calculated based on Ethnicity 
and Race fields on 
Demographics Tab 

All report types - Hispanic (anyone who is Hispanic, 
regardless of race) 
- American Indian/ Alaskan Native 
- Asian/ Pacific Islander 
- Black or African American 
- White 
- Unknown 
- Not specified 

HIV Status HIV status on Demographics 
Tab 

All report types Client’s current HIV status; Values 
include: 
- HIV-positive (not AIDS) 
- HIV-positive (AIDS status unknown) 
- CDC defined AIDS 
- HIV-negative (affected) 
- Unknown 
- HIV-indeterminate 

Date of HIV Diagnosis HIV diagnosis date on All report types HIV diagnosis date 
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Variable Name CAREWare Field Report Type Description/Values 

Demographics Tab 
Date of AIDS 
Diagnosis 

AIDS diagnosis date on 
Demographics Tab 

All report types AIDS diagnosis date 

HIV Risk Factor Calculated based on risk 
factors on Demographics Tab 

All report types Clients can select multiple risk 
factors, however, this field only 
selects one risk – the one that is the 
most likely mode of transmission 
based on the CDC’s transmission 
category hierarchy 

Zip Code Zip code entered for address 
on Demographics Tab 

All report types Zip code of where client primarily 
resides; if client is homeless, refers 
to where client is most often or the 
agency’s zip code 

Fields on Service Tab 
Service Category Does not appear in 

CAREWare 
Service General service category; for 

example medical case 
management, NOT eligibility, 
service plan, etc. 

Service Short Name Service drop down menu 
on Add Service screen 

Service Specific service name; for 
example Part A eligibility 

Service Long Name Service drop down menu 
on Add Service screen 

Service The Specific service name and the 
service category; For example: 
Part A Eligibility; Medical Case 
Management 

Service Contract May or may not be visible 
in Add Service screen 

Service If agency has multiple contracts, 
specifies which one 

Employee Name DD 
(Srv. Custom) 

Employee drop down field 
in Add Service screen 

Service Name of employee who 
completed and/or entered 
service; there are several 
employee name fields so verify 
you select the correct one; this 
field is used most commonly 

Service Date Date entered in Add 
Service screen 

Service Date service was received 

Service Comment 
(Srv. Custom) 

Comments entered in Add 
Service window 

Service Comments entered in service 
window 

Service custom 
fields 

Any additional fields in the 
Add Service window 

Service These are customized for specific 
agencies and services.  Use the 
field dictionary to find custom 
fields. 

Date of Last Service Calculated based on 
Services window 

Service Date of last service, regardless of 
service category 

Enrollment Status At top of Services window Service Status is specific to each agency; 
values include: 
- Active 
- Unknown 
- Referred or Discharged 
- Removed 
- Incarcerated 
- Relocated 
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Variable Name CAREWare Field Report Type Description/Values 

Annual Review Fields from Annual Review Tab 
Primary Health 
Insurance 

Annual Sub-Tab under 
Annual Review Tab 

All Report 
Types 

Last Primary health insurance 
entered for the Clinical Review 
Year selected in top right hand 
corner of custom reports 
window 

Housing Status Annual Sub-Tab under 
Annual Review Tab 

All Report 
Types 

Last Housing Status entered 
for the Clinical Review Year 
selected in top right hand 
corner of custom reports 
window 

Household Income Annual Sub-Tab under 
Annual Review Tab 

All Report 
Types 

Last Household Income 
entered for the Clinical Review 
Year selected in top right hand 
corner of custom reports 
window 

Household Size Annual Sub-Tab under 
Annual Review Tab 

All Report 
Types 

Last Household size entered 
for the Clinical Review Year 
selected in top right hand 
corner of custom reports 
window 

Poverty Level Annual Sub-Tab under 
Annual Review Tab 

All Report 
Types 

Calculated using last 
household income and size 
entered for the Clinical Review 
Year selected in top right hand 
corner of custom reports 
window 

Lab Report Values from Encounters Tab 
Lab Test Lab type in Labs Rapid 

Entry window  
Lab The name of the test; for 

example, CD4, Viral Load, etc. 
Lab Result Result entered in Labs 

Rapid Entry window 
Lab  Lab value; for example 500, 20, 

etc. 
Lab Date Date entered in Labs Rapid 

Entry window 
Lab Collection date of lab 

Lab = ? =, <, or > sign entered in 
Labs Rapid Entry window 

Lab If lab has range, sign 
corresponding with range 

Lab Comment Comments entered in Labs 
Rapid Entry window 

Lab Any comments entered by person 
entering data 

First Quantitative 
Lab Date 

Calculated based on fields 
in Labs Rapid Entry 
Window 

All report 
types 

NOTE: the criteria for this field 
must be specified; to do so, click 
the ellipsis next to the field name 
and edit the criteria 

First Qualitative Lab 
Value 

Calculated based on fields 
in Labs Rapid Entry 
Window 

All report 
types 

NOTE: the criteria for this field 
must be specified; to do so, click 
the ellipsis next to the field name 
and edit the criteria 

Last Quantitative Calculated based on fields All report NOTE: the criteria for this field 
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Variable Name CAREWare Field Report Type Description/Values 

Lab Date in Labs Rapid Entry 
Window 

types must be specified; to do so, click 
the ellipsis next to the field name 
and edit the criteria 

Last Qualitative Lab 
Value 

Calculated based on fields 
in Labs Rapid Entry 
Window 

All report 
types 

NOTE: the criteria for this field 
must be specified; to do so, click 
the ellipsis next to the field name 
and edit the criteria 
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9. Additional Resources 
 
For additional resources on CAREWare reports, database structure, and field definitions consult 
the following resources: 
 

• The jProg website (the developers of CAREWare) 
http://www.jprog.com/wiki/All-CAREWare-documentation.ashx 
 

• Target Center Data and Reporting page: 
https://careacttarget.org/category/topics/data-reporting 
 

• Sign up for the CAREWare listserv to get updates and hear what other jurisdictions are 
doing.  To sign up go to: 
https://list.nih.gov/cgi-bin/wa.exe?A0=CAREWARE 
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